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Chapter I 

Introduction 

Measurement of event-related potentials (ERPs) are based on 

electroencephalogram (EEG) signals associated with specific stimuli or impulse 

presentation. The processes in the brain are recorded using this technique with a 

precision of milliseconds (Gaudreault et al., 2013). ERPs are thus a specific type of 

EEG and are perceived as a subset of evoked potentials (Casey, 2010). The electrical 

response for each stimulus will be added across the repeated presentations, and the 

measures are then amplified, summated, and averaged (Kuperberg, 2008). This 

reduces artifacts of electrical activity that typically co-occurs with the activity in 

response to the intentional stimulation. Event-related potentials (ERPs) are an 

objective parameter that reflects the cognitive functions, and they are called cerebral 

responses which are associated with psychological events (Grover et al., 2012; 

Tanriverdi, 2009). ERPs are not affected by educational and cultural influences and 

could be a useful, non-invasive means for the cognitive process exploration (Lai et al., 

2010). 

ERP events can be measured for any type of somatosensory, olfactory, visual, 

or auditory stimulation.The evoked potentials are categorized into exogenous 

potentials and endogeneous potentials. The endogeneous potentials (N100, P200, and 

N200; early waves reaching the peak approximately within the first 100-200 

milliseconds after stimulus) are also termed as sensory potentials as they are greatly 

affected by stimulus physical features, like, intensity and frequency (Kuperberg, 

2008). The ERPs occurring later are categorized as endogenous potential or cognitive 

potentials (P300), which reflect only cognitive abilities. These ERPs are sensitive to 

alternations in the mental state of the subject which reflect the meaning of the 
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stimulus (Kuperberg, 2008; Sur & Sinha, 2009). Thus, P300 assess the information 

processing ability and the waveforms are characterized according to latency and 

amplitude (Sur & Sinha, 2009). 

In particular to visual or auditory stimulation, the related cognitive component, 

which is related to attention and memory processes is the P300 ERP component 

(Grover et al., 2012). This evoked potential is the measure of endogenous cognitive 

process that is directed attention and the context-specific updating of working 

memory (Turetsky, 2007). The task involves appreciation or identification or 

recognition of infrequent stimuli in an array of frequent stimuli. Hence, this can be 

used for the assessment of attention and working memory. P300 is recordable from 

various cortical and subcortical positions and it has a maximum amplitude in the 

central-parietal regions in the midline. Large foci of P300-generating cerebral tissue 

tend to be found in the hippocampus, superior temporal sulcus, prefrontal 

ventrolateral cortex, and, possibly, intraparietal sulcus (Halgren et al., 1998; Kiss et 

al., 1989; Smith et al., 1990). 

The P300 potential has two components, namely P3a and P3b. The P3a 

component has its maximum amplitude in the frontal region, and the P3b has the 

maximum amplitude in the parietal-central region. The P3a peak can be triggered by 

passive attention, whereas P3b requires active attention. In other words, P3b is 

elicited during target stimulus processing, and it is a task-relevant potential. 

Depending on the focus of the study, a sensory stimulus (often auditory in the realm 

of aphasiology) is presented repeatedly. Even other sensory stimuli are found to elicit 

a P300 response like the auditory stimulus, but the commonly used one is the auditory 

modality. The descending order of clinical use of the stimuli is: auditory, visual, 
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somatosensory, olfactory, or even taste stimulation (Polich & Pitzer, 1999). Since 

studies tend to evaluate language processing and attention in language disorders, they 

rely on the auditory stimulus.  

When an infrequent tone is presented along with a series of frequent tones 

(oddball paradigm), in the absence of a task, it can yield a peak with short peak 

latency and maximum amplitude over the central and parietal regions, which is the 

P3a. Whereas, P3b is a task-relevant potential. Hence, when the ERP researchers 

mention the P300 waveform, they mean the P3b component. The P300 is easily 

observable, and it mirrors the attention and working memory processing (Polich, 

2007). P300 can be quantified using two variables, which are latency and amplitude. 

Latency is related to information processing time, and amplitude is related to the 

attentional level (Rossini et al., 2007). It is reported by Polich (2000) that, the 

amplitude of P300 is the measure of activity occurring in the central nervous system, 

that happens in response to the production of stimulus memory representations and 

that is proportional to the number of attentional resources allocated to a particular 

task. If the latency of the P300 is prolonged, it means that the person is taking more 

time for processing information, and if the amplitude is less, it means that the person 

has an attentional deficit.  

A review article by Nieuwenhuis et al. (2005), stated that the P300 component 

is associated with decision-making. Zhang et al. (2013) carried out a study on six 

healthy females. For obtaining behavioral measures participants were asked to play a 

monetary gambling game by pressing the letters  “F” or “J” on a conventional 

computer for gambling. Behavioral data (the frequency of strategy switching and the 

risk ratio) were obtained using the E-prime software. Then the event-related potentials 
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were also recorded. The P300 component was larger following wins and after strategy 

switching. According to them, the changes in the decision-making process across the 

subsequent trials were related to the amplitude of the P300 (fronto-central P3a) and 

found that P300 is related to the decision-making process in normal individuals.   

The usual task used for recording P300 is the oddball paradigm which 

generally evaluates the classic P300 (P3b). The tasks given to the subjects were either 

with auditory or visual stimuli. In the auditory oddball paradigm, stimuli at different 

frequencies were presented, whereas, in a visual oddball paradigm, different figures 

were used (Jiang et al., 2015; Tsolaki, 2015). Oddball paradigms using syllables could 

be used to investigate the brain activation changes, during aphasia rehabilitation, as 

these paradigms using Norwegian (native language) syllables are related to speech 

sound processing (Becker &Reinvang, 2007a). 

A systematic review was done from January 2011 to January 2017 in a review 

article by Pavarini et al. (2018) on the P300 assessment. The P300 amplitude varied 

from 2.2 µV to 18.5 µV and the values of latency from 320 ms to 484 ms in healthy 

elderly subjects. Majority of the studies focussed on neurotypicals, persons with 

Dementia, and other clinical conditions. In the Indian context, the psychometric 

properties of aphasia therapy on individuals with aphasia can be objectively 

commented or evaluated by assessing the P300 potential. 

1.1 ERP- P300 in Adult Language Disorders 

 The P300 potential is seen to be affected in different conditions, in which there 

are problems with cognition, memory, or attention. There are many studies that state 

about the P300 amplitude and latency in conditions like, Alzheimer's Disease, 

Aphasia, Schizophrenia, Hypothyroidism, and other conditions in which there is 
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cognitive impairment or attentional deficit. Therefore, the cognitive functions in 

elderly subjects, including those with dementia, were evaluated. 

 The photographs of babies crying or smiling were shown to assess the visual 

event-related potential (P300). P300 was measured using this visual oddball 

paradigm, and the amplitude and latency were analyzed. It was found that the group 

with Dementia of the Alzheimer’s type had significantly longer latencies and 

significantly smaller amplitudes when compared to that of the healthy group (Asaumi 

et al., 2014). The deterioration of language, memory, and executive functions seen in 

individuals with Alzheimer's disease can be seen as a reflection in the P300 measures. 

The latency of P300 reflects impaired attention and cognition, which is associated 

with Alzheimer's disease (Bae et al., 2012). Thus, P300 is considered a biomarker for 

the detection of Dementia. 

 A study was also done to quantitatively analyze the cognitive skills of 

individuals having mild to severe hypothyroidism using P300. P300 was measured 

during thyroid insufficiency and in the 1st and 6th month of euthyroidism. Both mild 

and severe hypothyroid patients had prolonged P300 latencies when compared to 

controls. It was found out that, after the first month of euthyroidism, there was a 

notable decrease in the P300 latencies in the overt hypothyroid patients and there was 

no change in the latency values in the subsequent 6 months. But the latency of the 

group with mild thyroidism normalized at the 6th month of euthyroidism. This finding 

indicates that there are a variety of clinical outcomes of distinct thyroid insufficiency 

states on the human brain (Tütüncü et al., 2004), which can be indirectly measured 

through P300. 
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Regarding stroke patients, another study was done. Stroke patients with and 

without depression were also compared with a control group to find out the 

discrepancies in their P300. It was found that the post-stroke patients had higher P300 

latencies and lower P300 amplitudes when compared with the control group and the 

no depression groups (Zhang et al., 2019). In patients with aphasia, it was seen that 

they have difficulty in detecting and recognizing different phonemes from each other, 

and that is why they have a problem in word recognition and comprehension.  

Individuals with aphasia having mild or moderate auditory comprehension 

deficits and individuals with aphasia having severe or very severe auditory 

comprehension deficits were also compared during an active auditory discrimination 

task. It was found that there were no remarkable differences between a healthy control 

group, and the two aphasia groups, in terms of P300 amplitude. This finding was 

related to the simple behavioral task, and because the frequent and infrequent stimuli 

differed in more than one feature, that is the place of articulation and voicing (Becker 

& Reinvang, 2007b). 

Seventeen patients who were right-handed and diagnosed as having global 

aphasia post left-hemisphere stroke were studied. Once in a month, at the same time 

of the day after having breakfast, the recording of P300 was done. The infrequent 

stimuli were a 1 kHz tone, and the frequent stimuli were 0. 5 kHz. Apart from ERP 

recordings, neuropsychological and clinical assessment, CT scan, and routine blood 

evaluation were carried out for all patients. The language skills were assessed using 

the Aachen Test. Particularly two subtests were assessed: i) Token test and ii) 

Comprehension. The participants were also undergoing language rehabilitation. In the 

beginning, 7 patients showed P300 responses. Over time, all the participants exhibited 
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the P300, except for 1 participant. The language test was administered after 6 months. 

The participants with global aphasia who exhibited a P300 during the evaluation for 

the first month showed better improvement in their comprehension when compared to 

those who haven't exhibited it initially. The early presence of P300 post-stroke is a 

positive sign indicating progressive recovery of comprehension. The latency of the 

P300 waveform became longer throughout the observation window. Patients showing 

improvement in language comprehension who had earlier shown P300 indicates that 

passive P300 can be used to monitor the recovery in global aphasia (Nolfe et al., 

2006).  

In a standard rehabilitation program, eight individuals with aphasia, in the age 

range of 18 – 66 years received 8 – 12 hours of speech-language therapy per week. 

The recording of the P300 potential was done at admission (90 days post-injury) and 

discharge (mean 208 days). They were asked to press a button whenever they heard 

/ta/ syllable  which was presented along with /ba/ syllable. It was found that there was 

an increase in the amplitude of the P300 waveform, as well as an improvement in its 

latency for individuals with aphasia at the time of discharge (Becker & Reinvang, 

2007a). Thus, the studies using the event-related potentials (ERPs) which are based on 

the oddball-paradigm, to a greater extent helps to characterize, evaluate, and monitor, 

the phonological problems and auditory comprehension deficits in patients with 

aphasia. It was found that to monitor the patterns of recovery in the early stages of 

aphasia and follow up long-term periods, the P300 potential is a good non-invasive 

measure (Aerts et al., 2015). 
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1.2 Need for the Study 

Even though the data collected through behavioral measures provide useful 

information regarding the language deficits in individuals with aphasia, techniques 

which use event-related potentials (ERP-P300) directly assess the neurological 

functioning without solely depending on the behavioral measures since the majority 

of aphasia population have hemiplegia. ERP being a non-invasive assessment, may 

provide information regarding the role of the right hemisphere in language 

comprehension in those who have damaged the left hemisphere. If the tasks for 

recording the potentials are designed differentially to involve the hemispheres 

(example: use of syllables presented through auditory mode involves left hemisphere, 

use of designs presented through visual mode involves right hemisphere) and if it 

involves a non-differentiating or neutral task (example: picture image/orthographic 

word matched to implied meaning or designs matched with abstract meaning), it will 

provide much information about interhemispheric processing in persons with aphasia. 

Hence, ERPs can also be used to study the cortical level of language representation 

(Selinger, 1989). 

Among the various event-related potentials, the most likely used one is the 

N400 and P300 concerning the linguistic task of appreciating semantic incongruence 

event, which is found to be a sensitive marker for assessing the effects of therapy. It is 

because these potentials are easy to acquire with minimum involvement of the 

participants’ consciousness and voluntary responses.These neurophysiological 

assessments can be used to explore and monitor the plasticity patterns and therapy-

related differences in brain recovery (Aerts et al., 2015). Therefore, examining the 

event-related potential is another method of studying plasticity. 
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The P300 can be used as a prognostic tool for long term monitoring in 

rehabilitation medicine and used as an alternative to neuropsychological methods 

involving behavioral responses from the participants (with motor issues) during the 

assessment processes of individuals’ cognitive skills. It is reported in a study that as 

the early presence of P300 predicts the fast recovery of comprehension in patients 

with global aphasia, this potential is useful in post-stroke aphasia clinical evaluation. 

The presence of unstable P300 in individuals with global aphasia over time indicates 

cognitive failures in attention and discrimination (Nolfe et al., 2006). Thus, the 

additional advantage of ERPs is that they can be used to assess the cognitive 

processes of individuals, who are unable to give motor or verbal response (Becker & 

Reinvang, 2007b). 

ERP studies on effects of therapy on language functions and underlying 

neuronal circuits are rare. The outcome of such studies demonstrates the positive 

effects of treatments by portraying increased amplitudes of P300 (Aerts et al., 2015). 

Therefore, there is a need to monitor the individuals with aphasia and note their 

progress during their course of speech-language rehabilitation using 

neurophysiological assessment (P300) along with or without the routine behavioral 

language assessment. Hence, the present study was planned to carry out a P300 

assessment on individuals with aphasia and profile the P300 assessment of individuals 

showing the presence of the P300 component in comparison with the absence of the 

P300 component.  
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1.3 Aim of the Study  

The study aims to conduct a neurophysiological assessment (Event-Related 

Potential-P300) in individuals with aphasia at their pre-therapy period. 

1.4 Objective 

1) To measure the amplitude and latency values of ERP-P300 using 

auditory stimuli (speech stimuli) in individuals with aphasia at their 

pre-therapy period (< 5 sessions). 

2) To profile the P300 assessment of individuals with aphasia showing 

the presence of a P300 component in comparison of individuals with 

aphasia with absent P300 component. 
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Chapter II 

Review of Literature 

Electrophysiological evaluation is carried out to identify the physiology of the 

structures. Event-related potentials are being recently used to look into the brain 

functions more effectively. Auditory-evoked potentials (AEPs) or event-related 

potentials (ERPs) are responses obtained from the brain in response to some stimuli 

that is presented. The ERPs reflect the events that are happening in the human brain in 

response to the stimulus presented. There are two types of ERPs depending on the 

mechanism of the generation of responses. They are exogenous and endogenous 

potentials. Exogenous potentials are Auditory Brainstem Responses (ABR), Middle 

Latency Responses (MLR), N100, T-complex, etc., whereas potentials like P300, 

N400, P600, and, Contingent Negative Variations (CNV) are endogenous potentials. 

P300 is an ERP which is related to one’s attention and memory. 

2.1 P300 Event-Related Potential 

P300 is a positive potential occurring at around 300 milliseconds post the 

onset of the stimulus. It was first reported by Sutton et al in 1965. This particular 

potential can be elicited by presenting two stimuli in such a way that one is occurring 

around 80% of the time and the other one is occurring only 20%. Once the person can 

identify that the two stimuli that were presented are different, the positive peak is 

obtained at around 300 milliseconds after the onset of the stimulus. 

P300 amplitude is assumed to measure brain activity that is needed to retain 

working memory when the stimulus environment’s mental model, i.e., context is 

updated (Donchin et al., 1986). The P300 amplitude is also proportional to the amount 

of attention allocated on a given task (Kramer & Strayer, 1988) and has been linked 
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with superior memory performance (Fabiani et al., 1990). Therefore, P300 amplitude 

can be seen as a measure of CNS activity that represents the processing of input 

information as it is integrated into the stimulus memory representations and the 

setting in which the stimulus occurs. Hence, the variations in the amplitude of the 

P300 reflect the quality with which the incoming information is processed. In 

evaluating P300 amplitude, inter-stimulus interval (ISI) and the interval between 

successive target stimuli interact with likelihood: when the ISI is 6s or longer, the 

likelihood of stimulation decreases considerably (Polich, 1990 a, b). Squires et al. 

(1976) reported that when there was a successive repetition of the stimuli, there was a 

reduction in the P300 amplitude. The amplitude of P300 is also influenced by 

expectations produced by the sequence of stimuli occurring before the eliciting 

stimulus. 

The latency of the P300 waveform is considered as a measure of stimulus 

classification speed (Polich, 1987). P300 latency indicates the time needed for 

processing the stimulus or it indicates the speed of stimulus classification. The latency 

of P300 is not related to the process of response selection. The latency is also 

independent of the behavioral reaction time (Duncan-Johnson, 1981; Kutas et al., 

1977; McCarthy & Donchin, 1981). The P300 latency is a responsive temporal 

measure of the neural activity that underlies the attention allocation processes and 

immediate memory. Furthermore, in normal subjects, P300 latency is negatively 

correlated with mental activity, with shorter latencies associated with superior 

cognitive output (Polich et al., 1983, 1990b). The neuropsychological measures better 

associated with P300 latency are those that determine how rapidly subjects can assign 

and retain attention resources. This correlation is also confirmed by findings showing 

that P300 latency increases as the cognitive capacity of dementing disease decreases 
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(Squires et al., 1979) and in both normal and clinical populations, P300 latency is 

directly associated with cognitive capacity. 

2.2 Components of P300 

P300 potential has two components, P3a and P3b. The maximum amplitude of 

P3a is in the frontal region and the maximum amplitude of P3b is in the parietal 

central region. Passive attention triggers P3a peak and active attention results in P3b. 

In other words, P3b is elicited during target stimulus processing, and it is a task-

relevant potential. When the ERP researchers mention the P300 waveform, they mean 

the P3b component (Polich, 2007). 

2.3 Generators of P300 

Numerous investigations have been carried out to identify the generator sites 

of the P300 waveform. Understanding the P300 generating sites is as important as 

information concerning the P300 generator sites, as it provides insight into the various 

cognitive processes underlying them. It has been found out through various 

neuroimaging methods that the brain areas involved in the generation of P300 are 

complex as they have simultaneous activation of multiple sites which are overlapping. 

Using an oddball paradigm an infrequent tone is presented along with frequent tones 

without a task and it produces a positive wave with a central or parietal maximum 

amplitude distribution. This component is the "P3a" and it is distinguished from the 

task-relevant "P3b". In about 10 – 15% of normal young adults P3a can be readily 

observed from an auditory oddball task (Polich, 1988). This indicates that the 

generation of subcomponents varies across individuals. 

Even though appreciable progress has been made in identifying the neural 

generators of P300 in the last 25 years, it is not imprecisely delineated. P300 is 
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recordable from various cortical and subcortical positions. Large foci of P300-

generating cerebral tissue tend to be found in the hippocampus, superior temporal 

sulcus, prefrontal ventrolateral cortex, and, possibly, intraparietal sulcus (Halgren et 

al., 1995, 1998; Kiss et al., 1989; Smith et al., 1990).  

Patients with frontal lobe lesions showed a decrease in amplitude of P3a, 

while the same patients had a higher parietal amplitude for P3b. Consequently, 

integrity of frontal lobe is essential for generating P3a (Knight, 1984; Knight et al., 

1995). Patients with frontal lobe lesions showed the decreased amplitude of P3a while 

those having focal hippocampal lesions also showed reduced amplitude of P3a from 

novel distractors but normal components of P3b from targets (Knight, 1996). Initial 

hippocampal formation studies using depth electrodes in humans indicated that at 

least some portion of the P300 (P3b) is produced in the medial temporal lobe (Halgren 

et al., 1980). Evidence indicates that, given that part of this complex subcortical and 

cortical brain system remains intact, there is still the capacity to generate P300 

(Nieuwenhuis et al., 2005).  

2.4 Variables Affecting P300 

Many variables affect the latency as well as the amplitude of the P300 

waveform. They include the stimulus-related parameters, and the subject-related 

parameters respectively. 

2.4.1 Stimulus Related Parameters 

The various stimulus-related parameters like the stimulus intensity, stimulus 

probability, whether the task is active or passive, and the sound environment in which 

the testing is carried out affects the measurement of P300 potential. In an auditory 

oddball paradigm, the intensities of the stimulus were manipulated from 15 to 65 dB 
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to investigate its effect on P300 potential and it was found that intensity variations 

affected the P300 latency, but not amplitude (Papanicolaou et al, 1985). Vesco et al., 

(1993) found that there was a reduction in the amplitude along with longer peak 

latencies when low-intensity stimuli were presented.  

The P300 response is optimally evoked in an oddball test paradigm by erratic, 

infrequent acoustic stimuli randomly presented with a likelihood of 15 to 20 percent. 

The typically recommended probability for target stimuli in P300 measurement is 80 

percent for standard & 20 percent for deviant stimuli. A reduction in the stimulus 

target probability resulted in an increase in the amplitude and lengthening of peak 

latency, which was more evident in simple tasks than complex tasks (Polich, 2003).  

This potential can be elicited by either active or passive tasks. In an active 

task, the subject has to pay attention to the stimulus and respond, whereas, in passive 

mode, he or she is asked to selectively attend to the target stimuli. In a study carried 

out by Bennington and Polich (1999), they compared the effect of an active and 

passive task for auditory as well as visual stimuli on P300. They found out that the 

P300 amplitude was larger in the active condition (raising finger) than the passive 

condition (daydreaming) and it was more for auditory stimuli when compared to 

visual stimuli. The latency of P300 was shorter for auditory stimuli than the visual 

stimuli condition. In a study,  Kemal-Arikan et al., (1999) found that distinct 

differences in the P300 response occurs when the recordings were carried out with the 

stimulus presented in silent environment versus in background noise. The P300 is also 

influenced by the nature of the background sound. Amplitude reduced directly as a 

function of SNR when P300 was recorded with standard versus deviant stimuli 

presented in competing noise. 
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2.4.2 Subject Related Factors 

The subject-related factors like the subject's attention, state (whether he is 

sleepy or alert), motivation, memory, and whether he or she has consumed any drugs 

also have an impact on the potential. Any brain disorder affecting the primary 

cognitive operations of attention allocations and memory, will influence the P300 

measures by increasing the latency or reducing the amplitude (Polich, 2000). When 

the stimuli are ignored or when the attention is drifted away, the stimuli which usually 

elicits a P300 fail to do so (Hillyard et al., 1973). Polich (1987) reported that P300 

latency was longer and greater when the subject silently counted the target signal than 

when the subject pressed a thumb button.  

The presence of a P300 waveform varies with the stages of sleep. According 

to Cote (2002), when P300 was recorded with Fz electrode sites, P300 was absent in 

stage I and stage II. In rapid eye movement sleep (REM sleep) – stage V, where the 

brain is active similar to the awakened state, P300 was obtained. The subject’s 

motivation also affects the P300 response. In a study, Johnson (1989) found that a 

greater P300 is generated by adding monetary value to correct target signal 

recognition. When motivating instructions were given, a greater amplitude of P300 

was obtained than neutral ones.  

Caffeine was proven to increase the amplitude of P300 as it led to an increase 

in a CNS activity and eradicated the distinction in latency of P300 between tired and 

rested subjects that was evident in placebo circumstances. Research on the impact of 

acute ethanol consumption on P300 disclosed a change in the P300 neural generator 

to an inferior brain position (Lukas et al., 1990). The decline in P300 amplitude owing 
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to alcohol intake was significant across the right hemisphere compared to that of the 

left hemisphere (Porjesz & Begleiter, 1981).  

Memory patches for target signals are necessary as a yardstick for great 

representation. Stimuli which were distinguished are more likely to be tracked down 

and produced greater P300 components during encoding than those which were not 

remembered. Indeed, the P300 magnitude was affected by the rehearsal method, so 

the amplitude of the elements was greater than those which were consequently 

remembered if the respondents used rote instead of semantic strategies (Fabiani et al., 

1986). 

The relationship between P300 and long-term memory is investigated by 

Johnson et al. (1985). In their study, the subjects were given a list of target words, 

named the Study Series, which were to be memorized. These words were later 

examined for recognition by presenting them alongside new distracting words. Upon 

termination of these behavioral tasks, P300 was recorded using target stimuli alone. 

The findings of the study disclosed large P300 amplitude for target words, in 

particular,  in its initial presentation and shorter latency for those target words that 

were memorized by the participants in the behavioral task. Thus, there is a clinical 

relevance of P300 with the cognitive process called memory. However, the 

methodological issues related to P300 measurement with and without a behavioral 

task is still a questionable issue in certain clinical population associated with or 

without motor issues. 
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2.5 Applications of P300 Potential on Clinical Populations (Example: Adult 

Language Disorders) 

The P300 event-related potential has several applications. It can be used to assess 

the cognitive function, and the amplitude and latency of P300 in the normal 

population is not as same as that in the disordered conditions. In patients with brain 

damage, this particular potential is said to be affected.  

The foremost review is a systematic review carried out by Pavarini et al. (2018), 

in which P300 was assessed as a tool for cognitive assessment in healthy aging. 26 

studies that involved 940 participants were identified and all the studies reported that 

age influenced cognitive processing. One study reported that there was a decrease in 

the P300 amplitude as the age advances (van Dinteren et al., 2014). Another review 

article reported that an increase in latency as well as a decrease in the P300 amplitude 

was found as age advances. In this review study, 26 articles were selected and in those 

articles, 50% used visual mode of stimulus presentation, and 50% used auditory mode 

of stimulus presentation. In the articles that were selected 53.8% used P300 to identify 

whether age affected cognitive processing. P300 was used to compare the 

electrophysiological findings between cognitively impaired participants and healthy 

subjects in 19.2% of studies and it was used to monitor the effects of therapy in 15.4% 

of studies. Half of the articles selected showed that cognitive processing was 

influenced by age. According to Kuba et al. (2012) the latency of P300 rises by 

around 2 ms per year, as the amplitude reduces linearly in older people. The reviewed 

articles also showed that the latency values were ranging from 320 ms to 484 ms and 

the P300 amplitude values were ranging from 2.2μV to 18.5μV (Pavarini et al., 2018) 

for neuro-typical individuals.  
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The deficits in cognitive processing in different clinical groups are reflected by a 

prolonged latency of P300 or a decreased amplitude or total absence of the potential. 

The reduction of the amplitude of P300 was initially recorded 35 years ago and it is 

repeatedly replicated (Duncan et al., 2009). This result may be associated with 

observed frontal-temporal atrophy seen in many schizophrenic patients and their 

persistent attention deficit (Nuechterlein et al., 2006). Further study found that the 

amplitude of P300 was reduced in schizophrenia patients, but the differences were 

desirable for auditory but not visual stimuli (Duncan et al., 1987a). 

The cognitive functions of people with Dementia were also evaluated in different 

studies using event-related potentials like P300. In a study carried out by Asaumi et 

al. (2014), 48 elderly subjects were included. Visual oddball paradigm was used 

where the photographs of babies crying or smiling were shown to assess the event-

related potential (P300). The subjects were divided into the Dementia with 

Alzheimer's disease group, intermediate group (neither Alzheimer's disease nor 

healthy control group), and the healthy group. The event-related potential was 

recorded at Fz, Cz, Pz, and Oz positions, using Ag/AgCl electrodes, as given by the 

International 10-20 system, with the reference electrodes connected at the mastoids. 

The target stimuli were a crying or a smiling face and the non-target stimuli were a 

neutral face. The duration of the stimulus was 200 ms and the probability of the target 

stimuli was 20%. The subjects were asked to look at the baby's face on the screen and 

they were asked to push a button whenever they encountered the target stimuli. P300 

was measured using the visual oddball paradigm, and the amplitude and latency were 

analyzed. It was found that the group with Dementia of the Alzheimer's type had 

significantly longer latencies and significantly smaller amplitudes when compared to 

that of the healthy group. They reported that the P300 amplitude became smaller and 
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the P300 latency became longer in Alzheimer's disease patients, implying that 

Alzheimer's disease patients allocate a smaller amount of attention resources (Asaumi 

et al., 2014). Even though the P300 wave is a useful psychophysiological measure that 

is reflecting the cognitive functioning, the association between P300 indices and 

neuropsychological test measures in patients with Alzheimer's disease (AD) remains 

uncertain. 

Hence, Bae et al. in 2012 conducted a study on thirty-one patients with 

Alzheimer's disease and thirty-one healthy controls. The two groups were age and 

education level matched. When the patients with Alzheimer's disease were compared 

with the normal group it was found that Alzheimer's disease patients showed 

significantly reduced P300 amplitude, but there was no significant difference in P300 

latency between the two groups. The results suggest that the P300 potential is 

sensitive to the declination of executive functions, memory, and language which is 

seen in Alzheimer's disease patients. P300 can also be used as a biomarker for 

impaired neuropsychological function in patients with Alzheimer’s disease.    

P300 amplitude is noted to be less in people with alcoholism, and not as a result 

of the brain's deleterious effects of alcohol.Upon abstinence, many of the 

characteristic clinical and electrographic signs of alcohol dependency then return to 

normal; nevertheless, the reduction of the P300 amplitude persists. Studies have 

reiterated the utility of a decrease in P300 amplitude as a possible endophenotypic 

marker, indicating that the degree of reduction in P300 found in alcoholics was 

strongly associated with the number of alcohol-dependent individuals within the 

family (Duncan et al., 2009). 
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P300 is also been used to investigate the brain-injury survivors. In a study done 

by Duncan et al. (2005), 11 head injury survivors were selected as participants and the 

control group included 8 men who matched the brain injury survivors based on their 

age, handedness, and educational level. To elicit the event-related potentials, visual as 

well as auditory stimuli were used. The letters 'H' and 'S' were used as the visual 

stimuli and the high (1500Hz) and low (600Hz) were used as the auditory stimuli. It 

was found that the P300 waveform was significantly delayed in the brain injury 

survivors when compared to the healthy controls. The pattern of differences in latency 

indicates that the slower responses found in survivors were not due to receiving 

delayed feedback, but to taking longer to differentiate and categorize stimuli, and to 

choose and execute a response. A significant effect of head trauma tends to be the 

slowing down of auditory processes of the higher-order, believed to be the result of 

damage in the information processing system at several loci.The more prominent 

results seen on auditory than on visual tasks indicate that trauma may be more 

susceptible to the brain system that supports auditory processing than visual 

processing. 

In another study, the patients who were having Hashimoto’s thyroiditis and overt 

hypothyroidism were the participants enrolled in the study protocol. Among them, 13 

patients with overt hypothyroidism and twenty-four patients with mild thyroid failure 

were the participants included in the study. The P300 event-related potentials 

recording was carried out by the same clinician three times. The first recording was 

carried out at the beginning of the study, i.e., when the participants were having 

thyroid insufficiency and the second one was done after the establishment of 

euthyroidism (normalized plasma T3, T4, and TSH values) with levothyroxine 

supplementation. To evaluate the stability of the P300 the third evaluation was carried 
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out at least 6 months after the establishment of euthyroidism. As 4 participants in the 

severe thyroid failure group and six participants in the mild thyroid failure group 

didn't want to go for a third recording, the recording was not done for them. The third 

recording was carried out on the remaining 9 severe hypothyroid participants and 18 

subclinical hypothyroid participants. The healthy control group comprised of 

volunteers from the hospital set-up where the study was being carried out.  

The auditory oddball paradigm was used to record the P00 potential. Two tones 

of 1000 Hz and 8000 Hz were the stimuli that were used. The infrequent stimuli were 

8000 Hz which constituted 20% of the stimuli and the frequent stimuli were 1000 Hz 

which constituted 80% of the stimuli. The participants were asked to count the 

infrequent stimuli which were randomly presented in a series along with the frequent 

stimuli. Recording of the potential was done using silver electrodes placed on scalp 

sites Fz, Cz, and Pz (International 10-20 system). In the severe hypothyroid group, the 

TSH values, as well as the P300 latencies, were significantly higher than the moderate 

hypothyroid group at the beginning of the analysis. A reduction was seen in the P300 

latencies in the first month of euthyroidism in the severe hypothyroid group and they 

did not show any significant change afterward. Contrastively, there was an increase in 

the P300 latency seen in the subclinical group in the first month after reaching 

euthyroidism. It was noticed that overt hypothyroidism showed a pronounced delay in 

the P300 wave that normalized after establishing euthyroidism.While hypothyroidism 

indicated prolonged latency of P300, the recovery time of this potential was different 

in different groups of participants (Tütüncü et al., 2004). 

Apart from the above-mentioned adult language disorders, the present study 

focuses more on individuals with aphasia. However, there is also review related to 
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Event-related potentials like P300 being used in patients with aphasia. Event-related 

potentials (ERPs) have shown great potential in characterizing, evaluating, and 

monitoring language abilities in individuals with aphasia.  

2.6 Applications of P300 Potential on Clinical Populations (Example: Persons 

with Aphasia) 

Unexpectedly, the number of ERP studies measuring the effects of therapy on 

persons with aphasia and the reorganization of their neuronal circuits are very less in 

number. The outcome is nevertheless encouraging, showing positive results of 

extensive, impairment-based care in the form of greater P300 amplitudes in response 

to meaningful words. (Pulvermuller et al., 2005). From the studies, it was found out 

that the neurophysiological changes were strongly linked with the improved 

performance of behavioral language. Besides, despite the intact behavioral 

performance, ERPs may also shed light on potential defects in neuronal processing 

(Becker & Reinvang, 2007b). ERPs can provide a complimentary resource for 

diagnostic and therapeutic assessment of patients with aphasia, and facilitate clinical 

observations to also be related to neurological findings. This could not only help 

clinical practice but also increase understanding of the neurophysiological processes 

involved in language processing and their evolution after stroke (Kim &Tomaino, 

2008). Until now, the literature has not provided a long-term analysis of the linguistic 

abilities of individuals with aphasia during their initiation of therapeutic behavioral 

interventions in association with the neurophysiological assessment trends. 

Becker and Reinvang (2007a) studied the changes in brain activity related to 

speech and tone processing during aphasia rehabilitation. The participants were eight 

patients with aphasia and they underwent a standard rehabilitation program. The 
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program comprised of 8 to 12 hours of speech and language therapy per week and it 

was one to one therapy. The patients were in the age range of 18-66 years (3 men and 

5 women). All subjects were assessed in 2 sessions, that is, at admission (mean 90 

days after injury) and at discharge or shortly after (mean 208 days). The event-related 

potentials were obtained using 3 different paradigms; tone discrimination paradigm 

(passive), a syllable discrimination paradigm (passive), syllable discrimination, and 

identification paradigm (active).  

The speech stimuli were the Norwegian syllables /ba:/ and /ta:/. For the 

unattended paradigm, the patients were asked not to attend to the stimuli, instead just 

go through a magazine, and for the attended paradigm, they were asked to attend to 

the stimuli and to push a button in response to the target stimuli as fast as possible. It 

was found that all patients were able to differentiate the speech sounds and identify 

the target syllable /ta:/ except for one person (patient 5) who was only able to perform 

the task in the second session. When both the investigations were compared, it was 

seen that there was a significant increase in the amplitudes of both P3 and N2 

components at the ipsilesional frontal electrode site. Nevertheless, a change in the 

hemispherical distribution of amplitudes of the N2 component was seen. This 

suggests that the bilateral organization of the brain takes place during aphasia 

rehabilitation and that future ERP-rehabilitation research of aphasia should 

concentrate on ipsilesional frontal areas. There is also a need to profile the findings at 

the initiation of aphasia therapy. 

The same authors conducted another study in which they investigated syllable 

detection in patients with aphasia having processing deficits by event-related 

potentials. In this study, 20 patients with aphasia were recruited for rehabilitation and 
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11 control subjects were the non-brain damaged patients of the hospital and the 

hospital staff. All participants were identified to be right-handed, except for two 

individuals with severe aphasia and one individual with moderate aphasia. The 

comprehension of the participants was assessed using the Norwegian basic Aphasia 

Assessment (NGA) (Reinvang, 1985) and the Token test (De Renzi & Faglioni, 

1978). From the medical charts of the patients, the etiology and lesion locations were 

retrieved.  

Based on the comprehension of the individuals with aphasia they were divided 

into two groups: a group comprising of patients with aphasia having mild or moderate 

impairment in auditory comprehension (moderate aphasia group) and another group 

comprising of patients with aphasia having severe or very severe impairment in 

auditory comprehension (severe aphasia group). Both groups did not differ 

significantly from each other as well as from the control group in terms of their age, 

sex, time post-injury, or years of education. The stimuli presented were the syllable 

detection paradigm. The frequent or the standard syllable was /ba:/ and the infrequent 

or the target syllable was /ta:/. A total of 205 syllables were presented binaurally 

through headphones at around 80 dB SPL, and among these were 30 target syllables. 

The participants sat comfortably in a sitting chair or their wheelchair and were told to 

push a button with their chosen hand's index finger when they heard the target 

syllable  /ta:/ as soon as possible.  

The waveforms of standard syllable  /ba:/ were analyzed for the N1 component 

and the waveforms of the target syllable  /ta:/ were analyzed for N1 and the P300 

component. All the patients with aphasia except for 3 patients with severe auditory 

comprehension deficit detected all the 30 target syllables. In the controls, the P3 
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portion was observed as the typical large positivity with a maximum parietal peak at 

436 ms. In the moderate aphasia category, a much earlier maximum was observed. 

P300 was slightly attenuated in the severe aphasia category and it peaked over the 

frontal midline. Nevertheless, no major differences in mean amplitudes or latencies 

between groups were found in the P300 component. It indicates that there was no 

severe impairment in the detection of the target syllable. The lack of a difference 

between the two groups of patients with aphasia contrasts with the previous studies on 

P300. This might be due to the large difference between the two syllables selected for 

the study and also the simplicity of the task (Becker & Reinvang, 2007a). Hence, 

while selecting the stimulus for the study, the information provided in this particular 

study was considered. The advantage of this particular study is that they divided the 

patients with aphasia into two groups based on their impairment in auditory 

comprehension and then the event-related potentials were compared. Well, stimuli 

used were syllables that don't need much of language processing ability in the task. 

With reference to the aphasia rehabilitation period,  Nolfe et al. (2006) studied 

seventeen right-handed patients with lesions in the left hemisphere and with global 

aphasia. The study aimed at obtaining the percentage of patients who are having the 

P300 potential at the beginning of rehabilitation; to identify whether there is any 

improvement in the potential during the time of rehabilitation; and to identify the 

correlation between electrophysiological alterations and global aphasia recovery. All 

the participants were males and their mean age was 65 years. The mean interval 

between the onset of the stroke and the first recorded P300 was 12.9 days.  

The severity of the stroke at the onset was assessed using the Scandinavian 

Stroke Group ("Multicentre trial of hemodilution in ischemic stroke--background and 
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study protocol. Scandinavian Stroke Study Group.", 1985). The control group 

comprised 20 age-matched individuals and all the participants had normal hearing. 

Ag/AgCl electrodes were used for recording the potential. Potentials were recorded 

once a month after breakfast at the same time of the day. The stimuli used were high 

pitch (1000 Hz) target stimuli and low pitch (500 Hz) standard stimuli. To assess the 

language impairment, Aachen Test – validated for the Italian population (Luzzatti et 

al., 1987) was used. The two subitems which are token test and comprehension were 

assessed. All the patients were enrolled in a rehabilitation plan for 6 months. For 

treating their language impairment, Schuell's aphasia therapy was applied.  

In the recordings done at the beginning of rehabilitation, seven patients (41%) 

showed the P300 responses in the right hemisphere. When the patients were compared 

with the controls it was found that patients showed an increase in the latency which 

was significant. Only one among the 17 global aphasic patients did not show the 

response in 6 months and for only one patient the response was stable over time. The 

Token test and comprehension sub-items were assessed at the baseline and after 3 

months and 6 months. It was observed that the global aphasic patients who were 

having a P300 potential in the first month obtained better prognosis in their 

comprehension and the patients who lacked the P300 potential at the beginning 

showed the same score in their comprehension. Hence, the early appearance of P300 

after stroke was a good indication of recovery in comprehension. 

Till now only a few studies have focused on using neurophysiological 

assessments to assess the effect of therapeutic intervention on persons with aphasia. 

The prognosis of persons with aphasia can be assessed using the event-related 

potential P300. From the above-mentioned studies, it is understood that ERPs are a 
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useful method that can be utilized for identifying the individual activation patterns 

relevant to recovery in aphasia rehabilitation. 
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Chapter III 

Method 

The study aimed to to conduct a neurophysiological assessment (Event-Related 

Potential-P300) in individuals with aphasia (IWA) at their pre-therapy period. The 

objectives of the study were, to measure the amplitude and latency values of ERP-

P300 using auditory stimuli (speech stimuli) in IWA at their pre-therapy period and to 

profile the P300 assessment of IWA showing the presence of a P300 component in 

comparison with IWA showing absent P300 component.   

3.1 Participants 

A total of 3 individuals with Broca’s aphasia (non-fluent type) were selected 

based on the availability of cases in the Department of Clinical Services, All India 

Institute of Speech Hearing, Mysore. These participants had a diagnosis of 'Aphasia' 

by the Neurologists and the Speech-Language Pathologists after the administration of 

Western Aphasia Battery-K (Chengappa & Kumar, 2008). These individuals had just 

initiated their speech and language therapy and had attended less than five sessions 

before recruiting them for the present study. This period was noted as a pre-therapy 

period. The demographic details of all the participants of the clinical group are as 

follows in Table 3.1. 
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Table 3.1 

Demographic Details of Participants Included in the Study 

Sl No. Participants Age Gender Educational 

Status 

Aphasia type WAB scores AQ 

scores 

Neuro-imaging findings Languages  

known 

            SS N R AVC      

1. A  25yrs M Secondary 

Education 

 Global Aphasia  0 0 0 1.2 2.4 MRI: 27.08.19; Acute onset 

of aphasia and right sided 

weakness 

CT SCAN without contrast: 

05.09.19: Ill defined 

hypodensities in left peri-

rolandic cortex and temporo 

occipital cortex- sub acute 

infarcts. 

 

Kannada,  

English 

2. B 65yrs  M Nil Broca’s Aphasia 0 0 0 8.5 17 Hyperacute infarct involving 

frontal operculum and 

posterior frontal regions 

 

Konkani, 

Kannada, 

English & Hindi 

3. 

 

 

 

C  28yrs 

11 

months 

 M  Not 

mentioned 

Occupation:  

Fertilizing 

Manager 

(Agricultural 

dept.) 

 Global Aphasia 

(Resolving to 

Broca’s Aphasia) 

Re-

Evaluation:18.12.19 

Broca’s Aphasia 

 0 0.4 0.2 3.35 7.9  Left fronto-parieto-temporal 

lobe chronic infarct with 

gliosis 

Kannada, 

English, Hindi, 

Telugu, Tamil. 

0 0 0 4.4 8.8 
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The individuals with aphasia (participants) who had just initiated their speech-

language therapy followed special inclusionary criteria and the same are listed below;   

 The post morbid duration was six months or above.  

 Handedness was checked using Edinburgh handedness inventory - 

Revised (Williams, 2010), and the three individuals with similar (left) 

handedness (after the post morbid condition) only were considered for the 

present study.  

 Aphasia quotients were falling below 93.8 on the administration of 

Western Aphasia Battery – Kannada version (WAB-K) (Chengappa & 

Kumar, 2008).  

 Individuals with aphasia were monolingual or bilingual, and the languages 

known by the individuals were noted down. 

 They had no complaint about any otological problems or ototoxicity. To 

identify any such issues, a detailed general case history was taken.  

 Individuals with aphasia underwent a routine audiological evaluation 

before participating in the study. Air conduction thresholds were less than 

or equal to 30 dBHL in both the ears on Pure Tone Audiometry. (Clinical 

audiometer-Madsen OB922, (Version 2.64) with TDH 39 earphones 

enclosed in MX-41/AR supra oral ear cushions used to estimate the air-

conduction thresholds, and Radio Ear B-71 bone vibrator). 

 Individuals with aphasia had no other associated clinically significant 

neurologic disorders other than stroke. Participants, if taking any sedatives 

and memory dietary supplements, were asked to suspend them for 72 

hours before testing. 
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 Individuals with aphasia had no associated neurogenic speech disorders 

like apraxia or dysarthria, and if present, the same was noted during the 

evaluation processes.  

3.2 Research Design 

The present study was of single subject design, wherein profiling of 

neurophysiological assessments (ERP measurement of P300) of individuals with 

aphasia at their pre-therapy period was carried out. 

3.3 Data Collection Procedure- Electrophysiological Experimental Paradigm 

3.3.1 Testing Environment 

 The recording was carried out in a sound-attenuated and electrically shielded 

room, where the noise levels were within permissible limits (American National 

Standards Institute, 1999). For the same, the recording room of the Department of 

Speech-Language Sciences was used.   

3.3.2 Instrumentation  

The following instrument was used to record the stimuli and collect data. 

1. Net Station 5 Electrical Geodesic Inc. (EGI) Geodesic EEG Software 

(version 5.4.2) instrument was used to record Event-Related Potential 

(ERP) (128 Channels). 

2. The recorded stimuli which were scaled and RMS normalized were 

used to obtain the evoked potentials, viz., P300. 

3.3.3 Stimuli 

 The E-prime software version 2.0.8.90 (Psychology Software Tools, Inc., 

Sharpsburg, PA, USA) on a Hewlett Packard Z240 Tower Workstation (Intel Core 

i5at 3.20 GHz and 8.00 GB RAM) running Windows 7 Pro was used for the 
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preparation as well as the presentation of the stimulus. The EGI equipment supports 

two machines for carrying out the experiment. The Net Station software records 

multiple tracks of the stimulus along with the EEG data. Another computer generates 

and presents the stimuli, and it sends simple triggering or complex stimulus 

identification information to Net Station software. The speech stimuli used for testing 

were syllables /ḍa/ and /ga/, where the frequent one was /da/ and the infrequent one 

(target) was /ga/.  These audio stimuli were presented from an audiospeaker centred 

85 cm above the participant connected to a Creative SB X-Fi audio card. Speech 

sounds were presented free field at 70 dBSPL, measured by a Sound Level Meter 

(SLM). The interstimulus interval was 2000 ms. A total of 250 sweeps was presented. 

Participants were instructed to listen to the stimuli. The response to the task depended 

on the capability of the participants. A 700 msec time window was used, and analysis 

was based on the numerical values of the latencies (ms) and amplitudes (μV). P300 

identified as a positive deflection after the N1-P2-N2 complex was considered as 

responses for further analysis. 

3.3.4 Recording 

 3.3.4.1 Planning. The participants arrived at the recording room with freshly 

washed (not wet) hair and did not use any hair products (for example, gels or hair 

spray) when they came for recording. Before the participant arrived, the electrolyte 

solution was prepared, and the necessary items like measuring tape, pipettes, syringes, 

and three clean towels were kept ready.  

 3.3.4.2 Preparing the Electrolyte Formulation. As per the Electrical Geodesic 

Inc. (EGI) recommendation, HydroCel Saline (Potassium Chloride electrolyte 
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solution) was used for standard recordings. Following are the steps that were 

followed. 

1. 10 cc (2 teaspoons) of powdered potassium chloride (KCl) was added into the 

rinse/electrolyte bucket. 

2. 1 litre of warm distilled water was added to it. 

3. 5 cc (1 teaspoon) of Johnson’s Baby Shampoo was added to it. 

4. The ingredients were stirred vigorously until the KCl is completely dissolved. 

5. The solution was kept for 5 minutes. 

 3.3.4.3 Head Measurement. The head measurement was found out before 

applying the Geodesic Sensor Net to the subject’s head. The head circumference was 

measured by running the tape along the side of the head, above the ear, toward the 

back and 2.5 cm above the external occipital protuberance (Inion), around the other 

side and above the other ear, and back to glabella. One end of measurement tape was 

placed on the glabella, and the other end was placed on the Inion, and the midpoint 

was marked. Similarly, the midpoint between the pre-auricular joints were marked. 

The point at which these two intersect is the vertex point, otherwise called Cz in the 

international 10-20 system (Silverman, 1963). The Net of the appropriate adult size 

was selected based on the measurement obtained. Marking the vertex was as  follows: 

1. The subject was asked to hold one end of the measuring tape to the nasion. 

2. The tape was run over the top of the head until it reached Inion, and the 

midpoint was located. The midpoint was marked using a marker on the 

subject's head.  

3. The distance between the pre-auricular points were measured by extending 

the measuring tape across the top of the head. The midpoint was located, 
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and it was marked on the head. The intersection point of these two lines 

gave the location of the vertex.  

 3.3.4.4 Net Application. The Net was soaked in the electrolyte solution (as it 

has sponge inserts), and was safely applied on the participant’s head in such a way 

that the Cz electrode came on the vertex marked on the head. The participants were 

asked to remove earrings, glasses, and hair ties as it would become uncomfortable for 

them. The sensor net can be applied in less than 10 minutes without scalp abrasion, 

recording paste or gel, as the high-density geodesic sensor networks and related high-

impedance amplifiers have been developed to accept impedance values of up to 

100KΩ. 

  3.3.4.4.1 Soaking the Net in the Electrolye. The net was not soaked for a 

longer time, and care was taken so that the connectors not get wet. 

1. The sensor end of the Net was dipped into the “electrolyte” bucket. 

2. The sensors of the Net was dipped in electrolytes for at least 5 minutes to 

ensure adequate wetting of the sponges. 

3. A towel was given to the participants to catch the electrolyte drips.  

4. A towel was draped over the participant’s shoulders.  

5. The Net was lifted vertically out of the electrolyte bucket and was held in the 

same position, such that the excess electrolyte drip back into the container. 

          Then the Net was placed on the participant’s head in such a way that the 

electrode mentioned as Cz was coming on the vertex. It had to be ensured that all the 

electrodes were placed correctly on the scalp of the participant. The chin strap was 

moved underneath the participant’s chin and was secured using the cord lock. 

Participants were asked to rest on the chair and to remain awake throughout the 
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procedure. It was ensured that the interelectrode impedance was ≤ 50KOhms prior to 

testing. If the impedance was more, the electrolyte solution was put on the sponge on 

the electrodes. 

 The electrodes FCz and AFz were regarded as reference and ground, 

respectively during the online recording. Vertical (VEOG) and horizontal 

electroocculograms (HEOG), two additional electrodes, were used to monitor the eye 

movements. Particularly, VEOG was positioned at the right side of the right eye 

(Channels 8, 126, 25, 127), and HEOG was positioned below the left eye (Channels 

125 and 128). Impedances for all electrodes were kept below 50 KΩ, during the whole 

task. 

 The ERPs that were used to record was P300. P300 was recorded as per the 

guidelines provided by Duncan et al. (2009). Few of the important guidelines that 

were considered in the present study are: 

1. Use of oddball paradigm (passive paradigm, participants would only 

concentrate on stimuli without responses (Pokorny et al., 2013) - as it elicits 

robust P300 and reveals how the brain discriminates stimuli and process 

probability. 

2. A minimum of 36 or more artefact-free trials with correction for ocular 

contributions.  

3. The elicitor stimulus was delivered binaurally through speakers at 70 dB SPL. 

In order to elicit P300, the oddball paradigm was used. The summary of the 

protocol for recording is shown in Table 3.2. 
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Table 3.2 

 Summary of the Protocol for Recording P300. 

Stimulus Parameters Details 

Stimuli  Frequent  Infrequent  

 /ḍa/ /ga/  

Frequent to infrequent ratio  4 to 1 (80:20)  

Ear  Binaural 

Transducer Speaker 

Intensity  70 dB SPL  

Inter-stimulus-interval  2000 ms 

Total number of sweeps  250  

Acquisition Parameters                  

Filters 0.1 Hz -30 Hz 

Electrode  Cap electrode 

Montage Hydrocel GSN 128 1.0 

 

3.4 Data Analysis Procedure- Response Analysis 

Artifacts were automatically detected and manually verified for exclusion 

from additional analysis (bad channel >200 microvolts, eye blinks >140 microvolts, 

and eye movement >100 microvolts). For marking a channel bad, 50% or greater bad 

segments were used as the criteria for every channel; for marking a segment bad, 

greater than 20 bad channels were used as a criterion for every segment.  

Bad channels (fluctuations over 200 µV) were spherical spline interpolated 

from nearby electrodes. Data were baseline-corrected using a 100 ms window prior to 
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the onset of all stimuli. Data were re-referenced from vertex recording to an average 

mastoid reference. 

All artifact-free segments after processing were averaged by condition to 

produce a single event-related potential waveform for each condition for all 

participants and it was exported for plotting and statistical analysis. For analysis, the 

P300 was defined to be the most positive peak between 300 and 700 ms following 

stimulus onset. 

The obtained raw electroencephalogram (EEG) file from the Net Station 

Acquisition Program was subjected to preprocessing using the Net Station Tools 

program and further analysis was carried out using the EEGLAB toolbox within the 

MATLAB software (The Mathworks Inc., MA). 

3.4.1 Segmentation 

 The obtained continuous raw EEG data had to be segmented first. For this 

purpose, the Net Station Tools program was utilized. Initially, a segmentation tool 

was created using this program to segment the raw EEG data file. This segmentation 

tool was named “Speech segmentation”. Within the speech segmentation tool, the 

parameters were set in such a way that, segments containing the stimuli /da/ and 

segments containing the stimuli /ga/ were segmented. Each segment consisted of 

100ms duration before the presentation of the stimulus and 1500ms after the 

presentation of the stimulus. Thus, each stimulus was segmented in 250 segments 

(200 segments of frequent stimuli /da/ and 50 segments of infrequent stimuli /ga/). 

3.4.2 File Export 

Following the process of segmentation, the files had to be converted to Net 

Station Simple Binary format (.raw) to carry out further analysis using MATLAB. For 
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this purpose, the Net Station Tools program was utilized. A file conversion tool was 

created to convert the segmented files into the “.raw” format. This was executed for 

the speech EEG files to obtain converted files in the “.raw” format. 

3.4.3 Processing in MATLAB 

EEGLAB plugin (Swartz Center for Computational Neuroscience, CA)which 

is an interactive MATLAB toolbox for processing continuous and event-related EEG 

was used for further analysis. Further analysis in MATLAB was carried out according 

to Makoto's preprocessing pipeline 

(https://sccn.ucsd.edu/wiki/Makoto%27s_preprocessing_pipeline). The steps of 

processing in MATLAB are as follows: 

Step 1: MATLAB was opened and the EEGLAB toolbox was loaded into MATLAB 

by typing “eeglab” as shown in Figure 3.1.   

Figure 3.1 

Steps for Loading EEGLAB Toolbox to the Software 

 

 

Step 2: Importing the binary EGI data file was done for initiating the analysis process 

as shown in Figure 3.2. 

https://sccn.ucsd.edu/wiki/Makoto%27s_preprocessing_pipeline
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File > Import Data > Using EEGLAB functions and plugins > From Netstation binary 

sample file > Select the raw data > Ok 

Figure 3.2 

Steps to be followed for Importing the Data 

 

 

Step 3: Importing channel locations (Geodesic Sensor Net Hydrocel 128) was done to 

plot the EEG scalp maps either in 2-D or 3-D template and for approximating data 

source locations, the EEGLAB dataset must, therefore, hold information on the scalp 

locations of the recording electrodes.The channel location was imported and was 

applied as shown in Figures3.3 and 3.4. 

Edit > Channel Locations > Read Locations > Sample locs – GSN Hydrocel 128 > 

Autodetect – Ok > Opt Head Centre > Autodetect > Ok 
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Figure 3.3 

Steps to Import the Channel Location 

 

Figure 3.4 

Steps to Apply the Channel Location 
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Step 4: Data was then subjected to Finite Impulse Response (FIR) Filtering with a 

bandpass of 0.1 Hz to 30 Hz as shown in Figure 3.5. It was strongly suggested that 

continuous EEG data be filtered before epoch or artifact removal, even though epoch 

data may even be filtered with this function (each epoch being filtered separately). 

Continuous data filtering mitigates the emergence of filtering artifacts at epoch 

boundary and the data set is saved. 

Tools > Filter the data > Basic FIR Filtering > Set Lower and Higher edge of the 

frequency pass band as 0.1 Hz and 30 Hz respectively > Ok 

Figure 3.5 

The Steps to follow for Filtering the Data 

 

Step 5: Initially, the entire EEG data file was screened via scrolling manually through 

channel activities for bad channels and visual artifacts. These were removed 

manually. Following this, a clean raw data EEGlab plugin was applied for controlled 

objective rejection criteria as shown in Figure 3.6. 

Tools > Clean the data using clean raw data and ASR. Figure 3.7 shows the rejected 

data in red colour and the retained data in blue colour. 
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Figure 3.6 

The Steps followed for Cleaning the Data 

 

 

Figure 3.7 

The Window with the Rejected and Retained Data 

 

 

Step 6: Interpolation of all of the channels removed was carried out to reduce 

potential bias in the next average reference stage. For instance, if 128 channels exist 

and 20 channels are recognized as bad and rejected, but only from the right 
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hemisphere, then the number of channels in the left vs. the right hemisphere is 64 vs. 

44, with a mean bias towards the left hemisphere. To prevent such events, the 

channels were interpolated. In this procedure, when the cleaned data is processed, the 

researcher will note the missing rejected data as well as the channels selected in the 

filtered data set, and the dataset was saved as shown in Figure 3.8. 

Tools > Interpolate electrodes > Select from data channels – Note down the channels 

that are removed > Use specific channels of other data set > Dataset Index – Give the 

number of Filtered Dataset > Select the removed electrodes > Ok 

Figure 3.8 

The Steps followed for Interpolating the Electrodes 

 

 

Step 7: The data were re-referenced to the average reference because when the EEG is 

produced on a cortex with a dipolar current distribution and without external sources, 

there are at all times the very same number of positive and negative potential changes 

due to the retention of the charge. Therefore, scalp topography should be null. By re-
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reference to average channel values, we presume that there is (really) no generation of 

charges that are monopolar sources and sinks, and also the average reference is often 

very helpful in suppressing line noise. 

Tools > Re-reference the Data > Compute average reference > Ok as shown in Figure 

3.9. 

Figure 3.9 

 The Steps followed for Re-referencing the Data 

 

 

Step 8: Independent Component Analysis (ICA) was conducted. The decomposition 

of data by ICA (including PCA) includes a linear change of base from data gathered 

by single scalp channels to a spatially transformed "virtual channel" premise. In other 

words, rather than collecting simultaneously recorded single-channel data records, the 

data is processed into a collection of simultaneously recorded spatial filter outputs 

applicable to all multi-channel data, and 64 components with maximum channel 

activity representation were derived and components were classified using the IC 

label. 
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Tools > Decompose data by ICA > Commandline option – ‘pca’, 64 > Ok (as shown 

in Figure 3.10) and the components were classified by following these steps: Tools > 

Classify Components > View extended component properties > Component indices to 

plot – 1:64 (as shown in Figure 3.11) 

 

Figure 3.10 

The Steps followed for Decomposing the Data and the Components obtained after 

Following the Steps 

 

Figure 3.11 

The Steps followed for Classifying the Components 

 



47 

 

Step 9: SASICA plugin was applied to perform the automatic detection of artifactual 

components - The methods include 1). Autocorrelation, which identifies noisy 

elements with weak autocorrelation (usually muscular artifacts). 2). Focal components 

identify components that are too focal and are therefore unlikely to match neural 

activity (usually the wrong channel or muscle artifacts). 3). Signal-to - noise ratio, 

works by detecting components with a weak signal-to-noise ratio among both 

arbitrary baselines as well as interest time windows. After applying the plugin another 

window pops up showing the artefacts in red colour which makes it easier to remove 

the unwanted components as shown in Figure 3.13. 

Tools > SASICA > Autocorrelation – Enable; Focal components – Enable; 

Correlation with other channel(s) – Enable; Adjust selection – Enable > Compute (as 

shown in Figure 3.12) 

Figure 3.12 

The Steps followed for Applying the Plugin 
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Figure 3.13 

The Components with Artefacts in Red Colour 

 

Step 10: Independent Components (ICs) with eye-related or muscle-related 

components were removed, and ICs with activities of interest from the Brain 

(confirmed with the presence of dipoles and ERP waves) were selected as shown in 

Figure3.14. Tools > Remove components from data > OK > Accept > Save as a new 

file. After removing the unwanted components, the dataset was saved to extract 

epochs from this dataset. 

Figure 3.14 

Steps followed for Removing Unwanted Components 
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Step 11: Epochs were extracted from the retained ICs with the epoch limit of 0.1 

seconds before the stimulus onset and 0.8 seconds after the stimulus onset for both the 

frequent and the infrequent events. The steps followed were as shown in Figure3.15. 

Tools > Extract Epochs > Time locking event type – Select the event (for example: 

ga) – Epoch limit – Mention as “-0.1 0.8” – Ok  

Figure 3.15 

Steps followed for Extracting the Epochs 

 

Step 12: Baseline correction was carried out with a latency range of 100ms, where 

Baseline correction is a common method used during the analysis of event-related 

potentials, to account for irrelevant differences in the signal baseline. It is applied to 

an epoch data set by specifying a sub-window, where the mean value of the signal in 

that window is subtracted from the whole signal (by channel or component). The 

Figure 3.16 shows the baseline correction being applied. 
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Figure 3.16 

The Window that Pops up after Step 11 

 

Step 12: ERP image was plotted. The waveform of the P300 potential as well as the 

topographical representation was plotted.The Figure 3.17 shows the steps that were 

followed for plotting the ERPs and Figure 3.18 shows the P300 potential.  

Plot > Sum/Compare comp. ERPs. > Datasets to average – Give the dataset numbers– 

Ok 

Figure 3.17 

The Steps followed for Plotting the ERP 
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Figure 3.18 

The Event Related Potential P300 obtained after the Analysis 

 

 

Thus, the P300 responses were identified in each participant for the oddball 

paradigms, and it was analyzed to obtain the peak amplitude and latency. The average 

waves which were recorded for the target, as well as non-target stimuli, were 

compared. As the responses from different electrode sites were to be compared, the 

method mentioned by Bian et al., (2014), was used. In his study, he mentioned that 

electrodes should be focussed on during the analysis and he divided the electrodes on 

the sensor net into different regions to ease the analysis procedure as shown in Figure 

3.19. 
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Figure 3.19 

Electrode Distribution of 128 Channel Geodesic Sensor Net with Reference to Bian et 

al., (2014). 

 

          To detect the EEG power in different areas of the brain, it was divided into five 

regions: namely, frontal (F), left temporal (LT), central (C), right temporal (RT), and 

posterior (P). The vertical line in the middle separates the regions into right and left 

hemispheres (Bian et al., 2014). The grey colour electrodes, which are in the 

outermost belt of electrodes of the sensor-net (19 channels - E43, E48, E49, E56, E63, 

E68, E73, E81, E88, E94, E99, E107, E113, E119, E120, E125, E126, E127, and 

E128) were not considered for analysis as they tend to show residual muscle artefacts 

(Calbi et al., 2019). For analysis, the frontal electrode sites, central electrode sites, 

midline electrodes, posterior electrode sites, and the left and the right-side electrodes 

were considered. Apart from these, topographical analysis at the cortical level was 

also carried out. 
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Chapter IV 

Results 

The primary aim of the study was to profile the neurophysiological assessment 

(P300) of individuals with aphasia. i.e., Participant-A, Participant-B, and Participant-

C, by checking for the presence or absence of P300 components through the analysis 

of waveforms in the particular electrode sites and commenting on the corresponding 

brain activation (active brain source configuration) of these individuals through 

topographical representation. Since the study comprised of only three participants, 

statistical analysis was not carried out. The results are organized under the following 

headings: 

 P300 Represented in the Recorded Waveform  of Individuals with 

Aphasia 

 Topographical Representation of P300 in Individuals with Aphasia 

4.1 P300 Represented in the Recorded Waveform of Individuals with Aphasia 

To obtain the waveform representing the P300 response, the analysis was 

carried out incorporating the electrodes (Appendix A) at different brain areas off line 

using Net station 4.5 software (Electrical Geodesics) and the corresponding amplitude 

and latency were noted. The interested electrodes were selected to detect EEG power 

in different regions and inter-/intra regions, the brain was divided into five regions: 

Frontal (F), Left Temporal (LT), Central (C), Right Temporal (RT), and Posterior (P). 

For the aim of the present study, the analysis was further divided and named under the 

following sub-headings (1). Posterior electrode site (Colour code - Orange- Appendix 

A), (2). Central electrode site (Colour code-Purple- Appendix A), (3). Midline 

electrode (Marked as a dotted line), (4). Frontal electrode Sites (Colour code-Pink- 
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Appendix A), (5). Left electrode site (Portion towards left side from the midline) and 

(6). Right electrode site (Portion towards right side from the midline). (7). Average.  

Out of the three participants who participated in the study, the P300 potential 

was present in only ‘Participant A’. Participant B and Participant C did not exhibit the 

P300 potential. Hence the P300 representation with reference to latency and 

amplitude at various electrode sites of ‘Participants A’ only is profiled in detail under 

the following sub-headings.  

4.1.1 Posterior Electrode Sites 

Figure 4.1 

Waveforms with P300 Responses for Posterior Electrode Regions of ‘Participant A’  

 

With reference to the brain region, the posterior region is one of the best noted 

in comparison with all other electrode sites. Figure 4.1 shows the responses from the 

electrode sites in this posterior region. The latency of the P300 potential is 460 ms and 

it has an amplitude of 0.549 μV.  
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4.1.2 Central Electrode Sites 

Figure 4.2 

Waveforms with P300 Responses for the Central Electrode Sites of ‘Participant A’ 

 

The responses from these electrodes were grouped as the central region.  

Figure 4.2 shows the P300 potential with an amplitude of 0.369 μV and a latency of 

460 ms. 

4.1.3 Midline Electrode Sites 

Figure 4.3 

Waveforms with P300 Responses for the Midline Electrodes Sites of ‘Participant A’ 

 

The responses from the midline electrodes were also analyzed and the 

corresponding waveform is shown in Figure 4.3. The P300 potential has an amplitude 

of 0.459 μV and a latency of 472 ms.  
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4.1.4 Frontal electrode Sites 

Figure 4.4 

Waveforms with P300 Responses for Frontal Region Sites of ‘Participant A’ 

 

The responses from the electrode sites of the frontal region are shown in 

Figure 4.4. The latency of the P300 potential is 460 ms and it has an amplitude of 

0.723 μV.  

4.1.5 Left Electrode Sites 

Figure 4.5 

Waveforms with P300 Responses for Electrodes of the Left side Region of the Brain of 

Participant A 

 

The responses picked up by the electrodes on the left side of the brain were 

grouped as left electrode sites. Figure 4.5 represents a latency of 460 ms and an 

amplitude of 0.464 μV of the P300 potential.  
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4.1.6 Right Electrode Sites 

Figure 4.6 

Waveforms with P300 Responses for the Electrodes of the Right side Region of the 

Brain of ParticipantA 

 

Similar to the left electrode site, the right electrode sites were also studied. 

The responses from the electrodes on the right side are shown in Figure 4.6. The P300 

potential has an amplitude of 0.331 μV and a latency of 460 ms.  

4.1.7 Average 

Figure 4.7 

Waveforms with P300 Response Averaged for the Speech Stimuli at all Electrode Sites 

of Participant A 
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The grand average from all the electrode sites is shown in Figure 4.7. The 

P300 potential has a peak latency at 460 ms and an amplitude of 0.512 μV.  

Figure 4.8 

Waveforms showing the Average Responses for Participant B 

 

Figure 4.9 

Waveforms showing the Average Responses for Participant C 

 

The P300 potential of Participants B and C are as shown in Figure 4.8 and 4.9.  
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The P300 potential was found to be absent in all of the electrode sites for 

‘Participant B’ and ‘Participant C’ for the auditory stimuli that were presented.  

To summarize, the P300 responses of the ‘Participant A’with reference to different 

electrode sites, the amplitude, and the latency value is tabulated in Table 4.1. From 

the table, it is observed that the latency is relatively prolonged for the ‘Midline’ 

electrode site in comparison with the other electrode sites. With reference to 

amplitude, the amplitude is highest for ‘Frontal’ followed by the ‘Posterior’ electrode 

site. Figure 4.10 and Figure 4.11 represent the latency and amplitude value separately 

for each electrode sites of Participant A.  

Table 4.1 

Overview of the Latency and Amplitude of the P300 Potential of ‘Participant A’ 

Electrode Sites Latency (ms) Amplitude (μV) 

Posterior 460 0.549 

Central 460 0.369 

Midline 472 0.459 

Frontal 460 0.723 

Left  460 0.464 

Right 460 0.331 

Average 460 0.512 
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Figure 4.10 

Graphical Representation of the Latencies across Different Electrode Sites 

 

Figure 4.11 

Graphical Representation of the Amplitude Values across Different Electrode Sites 
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4.2 Topographical Representation of P300 in Individuals with Aphasia 

 The topographical distributions of the mean amplitude and latency for the 

frequent and infrequent stimuli were studied for ‘Participant A’ who showed the 

presence of P300 potential (peak latency and amplitude) in comparison with 

‘Participant B & C’ who did not show the presence of P300.  

Topography distributions of the  P300 potential of ‘Participant A’ at the peak 

latency is represented in Figure 3.1.  

Figure 4.12 

Comparison of Activation at Peak for Participant A 

 

Note.The brain activation for the frequent and the infrequent stimuli are shown in the figure. The 

darker red shades in the posterior aspect of the brain indicatesbrain activation in response to the stimuli. 

Figure 4.12 shows the comparison of brain activation for the frequent and the 

infrequent stimuli at the peak latency. The darker shades for the infrequent one shows 

the brain activity for the infrequent stimuli at posterior electrode site to a greater 

extent than the other electrode sites. There is comparatively no brain activation seen 

for the frequent stimuli. The brain activation is seen in the form of scattered responses 

from the scalp regions of Participant A. 
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When the topographical representation of Participant A was compared with 

Participant B and C, it was relatively very dissimilar as shown in Figure 4.13. The 

brain activation from all the electrode sites for both Participant B and Participant C 

have been averaged in the figure shown below. Participant B shows minimal brain 

activity on the right hemisphere region and some regions of the frontal electrode sites 

of the left hemisphere, where as Participant C shows minimal amount of brain activity 

on the posterior aspect of the left hemisphere even though the P300 potential is 

absent. The minimum responses seen in the scalp regions of participant B and C are 

scattered responses from the brain. 

Figure 4.13 

Comparison of the Activation for all the Electrodes of ‘Participant B’ and 

‘Participant C’ 

 

 

Participant B Participant C 

Note. The darker red shades shows greater brain activation and the blue shades shows no activation 
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Chapter V 

Discussion 

The present study aimed to measure the amplitude and latency values of ERP-

P300 using auditory stimuli (speech stimuli) in individuals with aphasia at their pre-

therapy period (<5 sessions) and to profile the P300 assessment of individuals with 

aphasia. The analysis of the obtained data showed that only one among the three 

participants exhibited the P300 potential. An attempt has been made to justify the 

findings and to derive appropriate implications. 

          This discussion is organized into the following sub-headings: 

 P300 Potential and Topography  in Participant A  

 P300 Potential and Topography in Participant B 

 P300 Potential and Topography in Participant C 

 P300 Potential with respect to the Amplitude and Latency in 

Individuals with Aphasia and the Topographic Representation 

5.1 P300 Potential and Topography in Participant A 

The analysis was carried out for the three participants and, it was found out 

that only ‘Participant A’ exhibited the P300 potential. The analysis was carried out in 

detail for Participant A to identify whether there are any changes in the waveform in 

terms of its amplitude and latency concerning the different electrode sites, namely, 

frontal, midline, central, posterior, left and right electrode regions. 

          Participant A was diagnosed as having Global Aphasia after the evaluation and 

was observed to be showing significant improvement in WAB – K results at the time 

of pre-therapy evaluation. MRI findings showed ill-defined hypodensities in the left 
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peri-rolandic cortex and temporo-occipital cortex- subacute infarcts.  The scores of 

Spontaneous Speech (SS), Auditory Verbal Comprehension (AVC), Repetition (R), 

and Naming (N), were improving at the time of pre-therapy evaluation.The possible 

reason for this improved score on WAB- R could be the speech stimulation during the 

post morbid duration. With reference to the P300 assessment, the participant was 

giving attention to the stimulus on observation during the recording and was not 

getting distracted. The normative values for the P300 amplitude varied from 2.2 µV to 

18.5 µV in healthy elderly subjects (Pavarini et al., 2018). For normal healthy adults, 

the amplitude values of P300 range from 1.7 μV to 20 μV (Reis & Iório, 2007). 

However, the amplitude value for the P300 potential in Participant A was found to be 

reduced when compared to neuro-typical. This finding correlates to the review by 

Hagoort et al. (1996), suggesting people diagnosed with left-hemispheric lesion and 

aphasia showed reduced P300 amplitudes in a semantic-processing task when 

compared to controls. The present study involved only an auditory stimulus with no 

linguistic load.  

With reference to cognitive functions after stroke, Nolfe et al. (2006) 

concluded that P300 potential is an indicative assessment of the retained elementary 

cognitive function after a stroke affecting areas relevant for language production and 

processing. Participant A has retained elementary cognitive function as noted from the 

presence of the P300 potential. It has been suggested that the medial temporal lobe 

and the integrity of the temporoparietal junction play a role in modulating or even 

creating the P300 amplitude (Knight & Scabini, 1998; Picton, 1992; Polich, 2007). In 

persons with aphasia (global aphasia), significant infarct in the temporal lobe and 

temporoparietal junctions could have contributed to reduced amplitude. 
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When the different electrode sites were analyzed, the amplitude values were 

found to be varying from one region to another, with the highest amplitude in the 

frontal electrode sites. The descending order of the amplitude is: Frontal > Posterior > 

Grand average > Left > Midline > Central > Right. Some authors reported that young 

adults showed maximum amplitude at the parietal regions (Saliasi et al., 2013). 

According to Becker and Reinvang (2007b), some possible reasons for the amplitude 

reduction are, that, the electrophysiological changes observed might not be due to the 

language functions, but due to the impairment only in the acoustic processing. 

 Also, the amplitude attenuations may only be unspecific manifestations of 

brain lesion and lesion size that are not particularly linked to aphasia/the site of lesion 

in aphasia. Reduction in the amplitude when measured from electrodes in different 

locations, has a complex relationship with the underlying brain activity. Lesion effects 

such as atrophy, gliosis, or edema can influence the registration of activity from 

nearby generators (Korpelainen et al., 2000). 

The latency of the P300 potential varied from 320ms to 484ms in healthy 

elderly subjects (Pavarini et al., 2018). The P300 latency ranges between 250 and 

350ms for adults, according to Kraus et al. (1995). Didoné et al. (2016), reported that 

the minimum and maximum latency values were 247.5ms and 362.5ms, respectively, 

for participants in the age range of 18 -59 years when tone burst stimuli was used. In 

the present study, for Participant A the latency values were found to be prolonged and 

latency values were found to be constant across all sites of the electrode except the 

midline electrodes. In the literature,  according to Rossini et al. (2007), the latency of 

the P300 potential is related to the information processing time. Such findings can be 

correlated with the present study since the constant values across the majority of the 
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electrode site indicate that the time taken to process the stimuli remains the same. The 

latency value varied only when the response was obtained from the midline 

electrodes.  The possible explanation for the presence of the P300 event-related 

potential can be that most of the regions of frontal, parietal, and temporal lobe were 

collectively involved in information processing. Equal participation and collective 

involvement of all the lobes are required for information processing and hence this 

might have contributed to the same latency value in the case of Participant A. To 

support some from the review, the P300 potential was observed to be present in a 

person with an ischemic lesion in the left hemisphere involving the caudate nucleus, 

the anterior tip of the superior temporal lobe, the insula and the parietal lobe (Aerts et 

al., 2015).  

The P300 potential has a maximum amplitude in the central-parietal regions in 

the midline. Large foci of P300-generating cerebral tissue tend to be found in the 

hippocampus, superior temporal sulcus, prefrontal ventrolateral cortex, and, possibly, 

intraparietal sulcus (Halgren et al., 1998; Kiss et al., 1989; Smith et al., 1990).The 

lesion site and the size of the lesion at sub-cortical structures could have a different 

impact on the P300 potential generated as the activity from nearby generators, which 

could be possible in global aphasia. Another factor that could have attributed for the 

presence of the potential can be the attentional allocation to the stimuli.  

The event-related potential P300 is a potential that is related to the attention 

and the memory processes (Grover et al., 2012) and it requires active attention from 

the participant (Polich & Pitzer, 1999). The participant paying attention to the 

stimulus will increase the chances of the potential being present. Another possibility 

for the presence of the P300 potential may be the discrimination ability of the 
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individual. In a study by Becker and Reinvang (2007a), wherein individuals with 

moderate and severe aphasia were able to detect the target syllables among the 

standard syllables.They reported that the P300 did not significantly differ in the 

aphasic groups, indicating no severe impairments in target recognition and it implies 

that the individuals with aphasia were able to identify the target syllables 

behaviourally. But the electrophysiological variables were significantly attenuated in 

the stimulus discrimination in some of the individuals with aphasia. This indicates 

that the response was based on the acoustic features and not based on linguistic 

analysis. This can be applied to only those studies using stimulus as syllables that do 

not have any association with linguistic expression or comprehension. Thus, the 

acoustic variable of discrimination ability has played a major role to elicit a P300 

response. 

To summarize, the activation of peak latency in the topographical 

representation of P300 for Participant A showed the presence of brain activation for 

the infrequent stimulus at the posterior regions of the brain. There is a centroparietal 

generator for auditory as well as visual P300 for individuals in the age range of 16 – 

65 years (Sangal & Sangal, 1996). Similarly, Smith et al. (1990) reported parieto-

temporal generators for auditory P300.  

The brain activation seen in the case of Participant A was in the form of 

scattered responses from the scalp regions instead of centralised activation. The 

activation was absent for the frequent stimulus, which indicates that the brain has 

perceived the stimuli as being different, whereas, in the neuro-typicals  the 

topographical representation for the P300 potential was found to be having centralised 

activation (Pfefferbaum et al., 1984; Picton & Hillyard, 1974).  
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5.2 P300 Potential and Topography in Participant B 

          Participant B belonged to the geriatric population, and, was diagnosed as 

having Broca’s aphasia. He had very poor scores in spontaneous speech, naming, and 

repetition, whereas better auditory verbal comprehension scores on the administration 

of WAB-R. The MRI findings showed hyperacute infarct involving left frontal 

operculum and posterior frontal region, indicating that the lesion was localized to the 

frontal region. But even though the other regions were not affected, the potential was 

found to be absent.  

A possible reason might be the participant’s attention allocated to the stimuli 

that were presented, was very poor to elicit a P300 response. Studies have stated that 

P300 is a potential that depends on the attention of the participant (Grover et al., 

2012; Polich & Pitzer, 1999; Turetsky, 2007). For attentional allocation, the thalamus 

and the fronto-parietal network (Shomstein et al., 2012) were said to play a major 

role. In Participant B, the lesion was localized to the frontal region.  

Despite the good comprehension scores, the potential was found to be absent. 

Becker and Reinvang (2007b) studied the individuals with aphasia having mild or 

moderate auditory comprehension deficits and severe auditory comprehension deficits 

and both the groups didn’t show any changes in the P300 potential in terms of its 

amplitude. But the absence of the potential is contradicting another study by Nolfe et 

al. (2006), as their study reported that early presence of P300 post-stroke is a positive 

sign of recovery of comprehension.  

The age of the participant may be also acting on the presence of event-related 

potential. Pavarini et al. (2018) have stated in their review article that there is a 
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reduction in the amplitude of the potential and an increase in the latency of the 

potential in the healthy elderly population. Stenklev and Laukli (2004) gave a possible 

explanation that the participant’s age could also be a factor to result in reduced 

amplitude and prolonged latency. They reported that the presence of P300 is reported 

in only 52 percent of individuals over the age of 60.  

To summarize, the P300 potential was found to be absent, but there was 

minimal amount of brain activity present on the right hemisphere regions, and, some 

parts of the frontal electrode sites of the left hemisphere in the topographical 

representation of Participant B. Responses from the scalp regions were not in the form 

of centralised activation rather it was scattered. 

5.3 P300 Potential and Topography in Participant C 

          Participant C was diagnosed as having Global aphasia, but he was resolving 

into Broca’s aphasia. He showed very poor scores in spontaneous speech, poor scores 

in naming and repetition, and an average score in auditory-verbal comprehension. 

MRI findings showed Left fronto-parieto-temporal lobe chronic infarct with gliosis, 

indicating diffuse lesion. The absence of the event-related potential can be due to the 

presence of a diffuse lesion. Lesion involving the sites responsible for the potential 

might have caused the absence of the potential.The major areas contributing to the 

P300 potential are the hippocampus, superior temporal sulcus, prefrontal ventrolateral 

cortex, and, possibly, intraparietal sulcus (Halgren et al., 1995, 1998; Kiss et al., 

1989; Smith et al., 1990). Since all these areas are most affected in the case of 

Participant C, that might have led to the absence of the potential.Despite attending to 

the stimulus, the potential was found to be absent in Participant C. Participant C 

exhibited minimal amount of brain activity on the posterior aspect of the left 
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hemisphere in response to the speech stimuli that was presented, even though the 

P300 potential is absent.  

5.4 P300 Potential with respect to the Amplitude and Latency in Individuals with 

Aphasia and the Topographic Representation 

          The findings from the present study indicate that the event-related potential 

P300 is participant specific and cannot be attributed to the type of aphasia, attention 

of the participant, or size and the extent of the lesion, solely. Any of these factors can 

affect the presence of the P300 potential and it depends on the participant’s individual 

factors.These individual factors could be the age of the participants that affects the 

presence of the P300 potential. Pavarini et al. (2018) has reported that the amplitude 

of the P300 potential decreases and the amplitude increases in healthy elderly 

individuals.In one of the participants, despite better auditory comprehension scores, 

the potential was found to be absent. Here the individual participants factor and its 

relationship between deficits in auditory and speech sound processing and the 

language function in aphasia participants remains unclear.  

A study (Becker & Reinvang, 2007) reported that the participants with mild or 

moderate and severe auditory comprehension deficits were able to successfully detect 

the syllables that were used as the stimulus. Another factor that might have potentially 

influenced the result in the case of Participant B could be the psychological status of 

the person for example: depression. However, their general health condition would 

have been documented as an inclusionary criteria or in brief the psychological status 

could have been assessed by the professional in the present study, and this could be 

the further directions for further studies. Since, the prolonged P300 latencies were 

found to be related to post-stroke depression and post-stroke depression was found to 
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affect the long-latency ERPs (Korpelainen et al., 2000). Even though education and 

cognitive tests didn’t show any relationship to the electrophysiological results, it is a 

factor which is said to influence the age-related P300 results (Raggi et al., 2013).  

Another study reported better latency and amplitude values for participants 

without subjective memory complaints when compared to those with memory 

complaints (Smart et al., 2014). Post-stroke patients with depression were reported to 

have greater latencies and reduced amplitudes when compared to stroke patients 

without depression (Zhang et al., 2013). To summarize, the event-related potential 

P300 can be affected by several factors and it is participant specific. 
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Chapter VI 

Summary and Conclusion 

Event-related potentials (ERPs) is an objective parameter which reflects the 

cognitive functions, and they are called as cerebral responses which are associated 

with psychological events (Grover et al., 2012; Tanriverdi, 2009). In particular, the 

related cognitive component, which is related to attention and memory processes is 

the P300 ERP component (Grover et al., 2012). This evoked potential is the measure 

of endogenous cognitive process, i.e., directed attention and the context-specific 

updating of working memory (Turetsky, 2007). Hence, this can be used for the 

assessment of attention and working memory. The neurophysiological assessment has 

also been used as an alternative for behavioral responses, as it doesn't always require a 

response from the participant. ERPs can also be used to monitor the effects of 

therapeutic intervention on individuals with aphasia.  

Stroke patients with and without depression were compared with a control 

group to find out the discrepancies in their P300. It was found that the post-stroke 

patients with depression had higher P300 latencies and lower P300 amplitudes when 

compared with the control group and the no depression groups (Zhang et al., 2013). In 

patients with aphasia, it was seen that they have difficulty in detecting and 

recognizing different phonemes from each other, and that is why they have a problem 

in word recognition and comprehension. Thus, the studies using the event-related 

potentials (ERPs) which are based on the oddball-paradigm, to a greater extent helps 

to characterize, evaluate, and monitor, the phonological problems and auditory 

comprehension deficits in patients with aphasia. It was found that in order to monitor 
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the patterns of recovery in early stages of aphasia and follow up periods which are 

long-term, the P300 potential is a good non-invasive measure (Aerts et al., 2015). 

The present study aimed to conduct a neurophysiological assessment (Event-

Related Potential-P300) in individuals with aphasia at their pre-therapy period. The 

objectives of the study were, to measure the amplitude and latency values of ERP-

P300 using auditory stimuli (speech stimuli) in individuals with aphasia at their pre-

therapy period and to profile the P300 assessment of individuals with aphasia showing 

the presence of a P300 component in comparison of individuals with aphasia with 

absent P300 component.   

 A total of three participants were included in the study with non-fluent type of 

aphasia after they met the inclusionary criteria and the neurophysiological assessment 

(P300) was carried using an oddball paradigm. The stimuli used for recording were 

the syllables /da/ and /ga/, wherein /da/ was frequent and /ga/ was infrequent one. The 

participant was instructed to just pay attention to the stimuli that were being 

presented.  Net Station 5 Electrical Geodesic Inc. (EGI) Geodesic EEG Software 

(version 5.4.2) instrument was used to record Event-Related Potential (ERP) (128 

Channels) and the recording was done in a sound-attenuated and electrically shielded 

room, where the noise levels were within permissible limits (American National 

Standards Institute, 1999). P300 was recorded as per the guidelines provided by 

Duncan et al. (2009). Analysis of the obtained data was carried out using the 

MATLAB software. 

The results are organized under two headings, P300 represented in the 

recorded waveform of individuals with aphasia and topographical representation of 

P300 in individuals with aphasia. Out of the three participants who participated in the 
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study, the P300 potential was present in only Participant A. Participant B and 

Participant C did not exhibit the P300 potential. Hence the P300 representation with 

reference to latency and amplitude at various electrode sites of Participants A was 

only profiled in detail. It was observed that the latency was relatively prolonged for 

the midline electrode site in comparison with the other electrode sites. With reference 

to amplitude, the amplitude was highest for frontal followed by the posterior electrode 

site.   

The topographical distributions of the mean amplitude and latency for the 

frequent and infrequent stimuli were studied for Participant A who showed the 

presence of P300 potential (peak latency and amplitude) in comparison with 

Participant B and C, who did not show the presence of P300, where the increased 

brain activity for the infrequent stimuli at posterior electrode site was found to be 

greater than the other electrode sites, whereas no brain activation was seen for the 

frequent stimuli. The other electrode site regions had scattered activation for 

Participant A, B, and C, all being the clinical population,  possible reason for this 

results were illustrated  by Hagoort et al. (1996), whereas the present study involved 

only an auditory stimulus with no linguistic load. With reference to cognitive 

functions after stroke, Nolfe et al. (2006) concluded individuals with aphasia retain 

elementary cognitive function as noted from the presence of the P300 potential.  

It has been suggested that the medial temporal lobe and the integrity of the 

temporoparietal junction play a role in modulating or even creating the P300 

amplitude (Knight & Scabini, 1998; Picton, 1992;  Polich, 2007). In persons with 

aphasia (global aphasia), significant infarct in the temporal lobe and temporoparietal 

junctions could have contributed to reduced amplitude.  
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According to Becker and Reinvang (2007b), some possible reasons for this 

amplitude reduction are, that, the electrophysiological changes observed might not be 

due to the language functions, but due to the impairment only in the acoustic 

processing. The amplitude attenuations may only be unspecific manifestations of 

brain lesion and lesion size that are not particularly linked to aphasia/the site of lesion 

in aphasia.  

Participant A's latency values were found to be constant across all sites of the 

electrode except the midline electrodes. In the literature,  according to Rossini (2007), 

latency of the P300 potential is related to the information processing time. Such 

findings can be correlated with the present study, since the constant values across the 

majority of the electrode site indicate that the time taken to process the stimuli 

remains the same. The latency value varied only when the response was obtained 

from the midline electrodes. Equal participation and collective involvement of all the 

lobes are required for information processing and hence this might have contributed to 

the same latency value in the case of Participant A and not in case of other 

participants. The lesion site and the size of the lesion at sub-cortical structures could 

have a different impact on the P300 potential generated as the activity from nearby 

generators, which could be possible in global aphasia. Another factor that could have 

contributed for the presence of the potential can be the attentional allocation to the 

stimuli. Another possibility for the presence of the P300 potential may be the 

discrimination ability of the individual and the acoustic variable of discrimination 

ability has played a major role to elicit a P300 response. 

The topographical representation of the Participant A showed brain activity in 

the posterior aspect of the brain and the responses were scattered instead of 
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centralised activation. One possible reason for the reduced brain activation seen in 

case of Participant A may be because of either the lesion present in the brain or the 

attention allocated to the stimuli. 

The other contributing reasons to support the findings of Participant B, and C, 

would be the factors listed in previous paragraph along with these following 

additional factors. The age of the participant may be also acting on the presence of 

event-related potential. Pavarini et al. (2018) have stated in their review article that 

there is a reduction in the amplitude of the potential and an increase in the latency of 

the potential in the healthy elderly population.The major areas contributing to the 

P300 potential are the hippocampus, superior temporal sulcus, prefrontal ventrolateral 

cortex, and, possibly, intraparietal sulcus (Halgren et al., 1995, 1998; Kiss et al., 

1989; Smith et al., 1990). Since all these areas are most affected in the case of 

Participant C, that might have led to the absence of the potential.The topographical 

representation of Participants B and C did not show any significant brain activation as 

the P300 potential was absent. Minimal amount of activity was seen scattered across 

the frontal regions of Participant B, which may be because of the attention allocated 

to the stimuli.These findings suggest that event-related potential, P300 is participant 

specific and can be dependent on many factors like the type of aphasia, size and the 

extent of the lesion, language function, the age of the participants, post-stroke 

depression (Korpelainen et al., 2000).  

6.1 Implications 

One particularly interesting clinical use of ERPs in the diagnosis and treatment 

of aphasia would be measuring the language comprehension function. Comprehension 

abilities of patients are not always easy to assess and an additional approach is 
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required beyond clinical tests. The findings of the study highlighted the individual 

differences in the P300 potential when a neurophysiological assessment was carried 

out. This is a single subject design wherein the findings obtained for each of the 

participants were separately discussed. As the study comprised only a small number 

of participants, the findings cannot be generalized. In the future, studies can be carried 

out with a greater number of participants to identify the effect of different factors on 

the P300 potential. Studies that compare the effects of different types of stimuli can 

be carried out to find out its effect on the P300 potential. Effect of speech and 

language therapy on individuals with aphasia can be carried out using event-related 

potential P300. 

6.2 Limitations with Future Directions 

The present study focussed on individuals with aphasia during their pre-

therapy period. Post-therapy analysis, if carried out could have shown the effects of 

speech and language therapy on the P300 potential. Analysis of the responses 

obtained from the ipsilesional and contralesional areas of the frontal lobe was not 

compared. The study included only a smaller number of participants; hence the 

findings cannot be generalized. A comparison of the ipsilesional and contra-lesional 

responses from the frontal electrode sites has shown that the P300 potential was better 

at the ipsilesional frontal site (Becker &Reinvang, 2007). This comparison can be 

carried out in studies using event-related potential P300 in the future. The present 

study did not consider the post-stroke depression as a factor. Studies have shown that 

post-stroke depression can affect P300 potential. 
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Appendix A 

Electrode Selection to form specific sites 

 

Electrode distribution of 128 channel 

Geodesic sensor net with reference to 

Bian et al., (2014). 

 

Colour coded electrode distribution for 

the convenience of ERP analysis 

 

 

 

 

 

 

 

 Frontal (F) 

 Central (C) 

 

Midline (M) 

 Posterior (P) 

 LeftHemisphere 

 RightHemisphere 

 LeftTemporal 

 Right  Temporal 



II 

 

The interested electrodes were selected to detect EEG power in different 

regions and inter-/intra regions, the brain was divided into five regions: frontal (F), 

left temporal (LT), central (C), right temporal (RT), and posterior (P). 

Frontal: E32, E25, E21, E14, E18, E1, E26, E22, E15, E9, E2, E27, E23, E18, 

E16, E10, E3, E123, E24, E19, E11, E4, E124, E12 & E5; 

Central: E6, E7, E13, E20, E29, E30, E31, E36, E37, E42, E53, E54, E55, 

E79, E80, E86, E87, E93, E104, E105, E106, E111, E112 & E118;  

Posterior: E61, E62, E78, E60, E67, E72, E77, E85, E59, E66, E71, E76, 

E84, E91, E65, E70, E75, E83, E90, E64, E69, E74, E82, E89, and E95;  

Midline: E17, E15, E11, E6, E55, E62, E72 and E75;  

Right: E14, E8, E1, E121, E114, E100, E95, E89, E82, E83, E90, E96, E101, 

E108, E115, E122, E2, E9, E10, E3, E123, E116, E109, E102, E97, E91, E84, 

E76, E77, E85, E92, E98, E103, E110, E117, E124, E4, E5, E118, E111, 

E104, E93, E86, E78, E79, E87, E105, E112, E106, and E80; 

Left: E21, E25, E32, E38, E44, E57, E64, E69, E74, E70, E65, E58, E50, 

E45, E39, E33, E26, E22, E18, E23, E27, E34, E40, E46, E51, E59, E66, E71, 

E60, E52, E47, E41, E35, E28, E24, E19, E12, E20, E29, E36, E42, E53, E61, 

E54, E37, E30, E13, E7 and E31; 

Average: Average from all the electrode sites. 

 

 

 


